Velocity & Variable Relationships
Grade: 8th Grade

Recommended Timeframe: 13 classes

Unit Overview: Students will be introduced to the idea of distance, time, and velocity in

science class. They will then construct “mouse trap cars” to measure the relationships
between time and distance. They will also measure the difference produced by changing a
single variable, the lever arm. Students will record their data. After some work with the
Coordinate Plane and basic graphing skills, students will use their time and distance data to
create graphs in math class. Through their data they will explore the ideas of line of best fit
and the broader concept of data interpretation. From there, students will be able understand
the purposes of graphing, creating linear graphs, the uses of linear graphs, and the
relationships of bivariate data.
This mini unit can also act as a launch into a much lengthier and in depth math unit about
linear equations. Students can continue to use Vernier equipment to collect data and discern
linear relationships and their presentation as graphs. They will also continue work in science
class exploring the relationships of forces and their effects.
Essential Questions
Science: How do we measure motion?
Math: How do graphs allow us to interpret data?

Major Concepts
Science: Forces & Motion
Technology: spreadsheet (Excel), Vernier probes,
Engineering: Analyzing data from tests to
evaluate a design
Math: Linear Relationships

Suggested Lesson Sequence
Prerequisites
This unit is intended to be an introduction to the concepts of force, motion, and linear relationships.
Lesson 1
Math –Distributive Property (50 minutes)
Lesson Overview: Students will be able to apply the distributive property in to simplify expressions.
Science –Motion & Position (50 minutes)
Lesson Overview: Students will understand position and motion and apply those concepts to
measuring motion.
Lesson 2
Math –One‐Step Equations (50 minutes)
Lesson Overview: Students will be able to use inverse operations to solve one‐step equations.
Science – Speed and Velocity (50 minutes)
Lesson Overview: Students will understand how to measure speed, the formula for speed, and the

difference between speed and velocity.
Lesson 3
Math – Solving Two‐Step Equations (50 minutes)
Lesson Overview: Students will be able to solve two‐step equations.
Science – Lessons 3‐6: Building Mousetrap Cars (50 minutes)
Lesson Overview: The students will build their mousetrap cars that they will later use to collect data.
Lesson 4
Math – Solving Multi‐Step Equations (50 minutes)
Lesson Overview: Students will be able to simplify and solve multi‐step equations, including equations
with the distributive property and variables on both sides of the equation.
Science – Lessons 3‐6: Building Mousetrap Cars (50 minutes)
Lesson Overview: The students will continue to build their cars.
Lesson 5
Math – Solving Inequalities (50 minutes)
Lesson Overview: Students will solve and graph inequalities with one variable.
Science – Lessons 3‐6: Building Mousetrap Cars (50 minutes)
Lesson Overview: The students will continue to build their cars.
Lesson 6
Math – Review—Equations (50 minutes)
Lesson Overview: Students will review the concepts embedded in solving equations and prepare for
an assessment.
Science – Lessons 3‐6: Building Mousetrap Cars (50 minutes)
Lesson Overview: The students should finish building their cars and making sure that they will
actually work.
Lesson 7
Math – Equations Assessment (50 minutes)
Lesson Overview: Students will demonstrate mastery of solving equations.
Science – Manual Data Collection (50 minutes)
Lesson Overview: The students will collect data using stopwatches and meter sticks and/or tape
measures, so that they can calculate the speed of their cars.
Lesson 8
Math – The Coordinate Plane (50 minutes)
Lesson Overview: Students will recognize and graph ordered pairs on a coordinate plane.
Science – Data Collection with Vernier (50 minutes)

Lesson Overview: The students will collect data using the Vernier Labquest interface and a Vernier
motion detector.
Lesson 9
Math – Scatter Plots & Correlations (50 minutes)
Lesson Overview: Students will be introduced to the concept of relationships between two variables
and will be able to determine the correlation of a set of data.
Science – Redesign (50 minutes)
Lesson Overview: The students will spend some time modifying their cars in order increase their
velocity.
Lesson 10
Math – Plotting Data (50 minutes)
Lesson Overview: Students will create scatter plots based on the data collected observing their mouse
trap cars.
Science – Data Collection (50 minutes)
Lesson Overview: Students will collect data a final time, both manually and with the Vernier
equipment so that they can determine whether or not their modifications made a difference in their
car’s average velocity.
Lesson 11
Math –Lessons 11‐12: Graphing Your Motion (Vernier Lab) (50 minutes)
Lesson Overview: Students will recognize and graph ordered pairs on a coordinate plane.
Science – Data Interpretation (50 minutes)
Lesson Overview: The students will graph their data and discuss whether modifications changed their
rate of speed for their car.
Lesson 12
Math –Lessons 11‐12: Graphing Your Motion (Vernier Lab) (50 minutes)
Lesson Overview: Students will recognize and graph ordered pairs on a coordinate plane.
Science – Lessons 12‐13: Engineering Work Sample (50‐minute period)
Lesson Overview: Students discuss Engineering Work Sample and begin their own work sample.
Lesson 13
Math – Walk the Line Lab (50 minutes)
Lesson Overview: Students will use Vernier Lab to continue exploring relationships between two
variables.
Science – Lessons 12‐13: Engineering Work Sample (50‐minute period)
Lesson Overview: Students will continue their engineering work sample.

Materials, Tools, & Technology
standard classroom materials
Vernier labquests, 1 per group
(Lessons 8, 10, 14)
Vernier motion sensor, 1 per group
(Lessons 8, 10, 14)

STEM Professional Involvement Ideas
●

Mechanical Engineer

Vocabulary

distance
time
velocity
acceleration
lever
variable
coordinate plane
ordered pair
slope

intersection
trend
accuracy
line of best fit
linear
relationship
bivariate data

Standards
Science
MS-PS2-2 Plan an investigation to provide evidence that
the change in an object’s motion depends on the sum of
the forces on the object and the mass of the object.
MS-PS2-5 Conduct an investigation and evaluate the
experimental design to provide evidence that fields exist
between objects exerting forces on each other even
though the objects are not in contact.

Technology
6. Technology Operations and Concepts
Students utilize technology concepts and tools to learn.
Students:
Select, use, and troubleshoot tools efficiently.
Transfer current knowledge to learning of new
technologies.

Engineering
MS-ETS1-2 Define the criteria and constraints of a design
problem with sufficient precision to ensure a successful
solution taking into account relevant scientific principles
and potential impacts on people an dthe natural
environment that may limit possible solutions.

Math
6.EE.7 Solve real-world and mathematical problems by writing and
solving equations in the form of x+p=q and px=q for cases in which p,
q, and x are all nonnegative rational numbers.
8.EE.7b Solve linear equations with rational number coefficients,
including equations whose solutions require expanding expressions
using the distributive property and collecting like terms.
HS.A-REI.3 Solve linear equations and inequalities in one variable,
including equations with coefficients represented by letters.
8.F.4. Construct a function to model a linear relationship between
two quantities. Determine the rate of chance and initial value of the
function from a description of a relationship of from two (x, y) values,
including reading these from a table or from a graph. Interpret the
rate of chance and initial value of a linear function in terms of the
situation in models, and in terms of its graph or a table of values.
8.F.5 Describe qualitatively the functional relationship between two
quantiles by analyzing a graph. Sketch a graph that exhibits the
qualitative features of a function that has been described verbally.

Notes
Throughout this unit the term “standard classroom materials” is used to describe everyday
classroom materials students and teachers would be expected to have: class notebook,
pencil or pen, paper, etc. Any items not typically needed for a standard lesson will be
denoted specifically.
All handouts and activities provided by Jeff Journigan and Kristen Tompeck unless otherwise
acknowledged.
Appendices
Appendix A: Teacher Resources
Appendix B: Student Resources

Distributive Property — Math Lesson 1
Grade
Time
8th grade
50 minutes
Subjects: Math
Level:
Needed:
Objective: Students will be able to apply the distributive property to simplify expressions.
Standards:
Background Information:
A solid foundation in order of operations should
Math
be established prior to beginning this unit. The
7.EE.1 Apply the properties of operations as
lesson sequence is designed to give students
strategies to add, subtract, factor, and expand
exposure to real life occurrences of relationships
linear expressions with rational coefficients.
between two variables before they begin to
explore the concepts of slope and intercepts.
Materials:
standard classroom materials
student handouts, App. B
Exit Ticket, App. B

Vocabulary:
distribute
equivalent expressions
term
coefficient
variable
constant

Resources:
App. B—Lesson 1: Math: Distributive Property Guided Lesson Notes and Distributive Property
Sort Activity
Procedures:
1. Distribute lesson notes: allow students to complete Motivation. Review and discuss.
2. Review lesson handout, have students annotate as they follow along. Complete model
problems using gradual release scaffold.
3. Distribute “sort”; allow students to work in pairs. Each student receives a group of 12
expressions. Each expression is equivalent to three other expressions. Students should sort
the expressions into three groups of four equivalent expressions. Once they have double‐
checked their groups, student can affix their equations to their handout.
4. Wrap up: Distributive Property Exit Ticket
Differentiation:
Supports
Extensions
Distributive Property Sort, second set
Assessment Opportunities:
Exit Ticket, App. B
Citations:

One‐Step Equations — Math Lesson 2
Motion & Position — Science Lesson 1
Grade
8th Grade
Level:
Objective:

Time
50 minutes.
Needed:

Subjects: Science

Learn how to describe an object’s motion and position.

Standards:
Science
MS‐PS2‐2 Plan an investigation to provide
evidence that the change in an object’s motion
depends on the sum of the forces on the object
and the mass of the object.

Background Information:
The location of an object is called its position and all
motion can be described by an object’s change in
position. The change in an object’s position has be
be described in relation to another object’s position
which is called a reference point.

Materials:
standard classroom materials
computer and web address

Vocabulary:
reference point
motion
position

Resources:
● None Provided
Procedures:
1. The students will be asked to define how they know if something is moving. They will then be
asked to describe how fast they are currently moving.
2. The class will look online for their speed compared to the center of the Earth (approx 1000
mph), the speed around the sun (approx 66,000 mph), and the speed around the black hole at
the center of our galaxy (483,000 mph). Describe how to get to somewhere from their house
without naming any specific objects. Discuss the importance of using reference points to
describe locations and positions.
3. Have students walk forward while tossing a ball. Have students draw pictures and discuss what
they see both as the person tossing the ball and as someone who is sitting nearby watching the
motion of the ball.
Differentiation:
Supports

Extensions

Assessment Opportunities:
None Provided
Citations:
● Scale information found at http://astrosociety.org/edu/publications/tnl/71/howfast.html.

Grade
Time
8th grade
50 minutes
Subjects: Math
Needed:
Level:
Objective: Students will be able to use inverse operations to solve one‐step equations.
Standards:
Background Information:
This lesson should be a review of a concept
Math
introduced at the 6th grade level. This lesson is
6.EE.7 Solve real‐world and mathematical
problems by writing and solving equations of the intended to be review, something upon which
form x+p=q and px=q for cases in which p, q, and students can build comfort and fluency working with
x are all nonnegative rational numbers.
inverse operations.
Materials:
Vocabulary:
isolate
standard classroom materials
inverse operations
Order of Operations Dice Activity, App. B
term
student handouts, App. B
coefficient
Exit Ticket, App. B
variable
constant
Resources:
 App. B: Lesson 2—Math: One‐Step Equation lesson notes and example problems
Procedures:
1. Begin with Order of Operations Dice Activity. Students work in pairs, roll dice and complete
rounds to practice order of operations and computation skills.
2. Distribute lesson notes, allow students to complete Motivation. Review and discuss.
3. Review lesson handout, have students annotate as they follow along. Complete model
problems using gradual release scaffold.
4. Wrap up: One Step Equations Exit Ticket
Differentiation:
Supports
Extensions
Assessment Opportunities:
Exit Ticket, App. B
Citations:
Exit Ticket adapted from Core Focus on Linear Equations SMC Curriculum, p18

Speed and Velocity — Science Lesson 2
Grade
8th Grade
Level:
Objective:

Time
50 minutes
Needed:

Subjects: Science

How to calculate an object’s speed. How to describe an object’s velocity.

Standards:
Science
MS‐PS2‐2. Plan an investigation to provide evidence
that the change in an object’s motion depends on
the sum of the forces on the object and the mass of
the object.

Background Information:
Speed describes how far an object travels in a given
amount of time and the formula is thus S=D/T where
the units of speed (S) are given in the unit of distance
(D, any measured distance) over time (T, in any
measured unit of time).

Materials:

Vocabulary:

balls
stopwatches

speed
velocity
acceleration

Resources:
●
Procedures:
1. Students see a ball being rolled across the floor at two different speeds.
2. They are asked if and how they know which roll is faster.
3. They use stopwatches to see if they can provide data to compare the actual speeds of the rolls.
4. Class discusses speed and how to calculate it.
5. The students measure balls that they roll on their own at three different speeds.
6. Class discusses the differences between speed and velocity.
Differentiation:
Supports
Working with partners and small groups.
Assessment Opportunities:
None provided.
Citations:

Extensions
Calculate speed of a faster moving object, such as
cars that drive by the school.

Solving Two‐Step Equations — Math Lesson 3
Grade
Time
8th grade
50 minutes
Subjects: Math
Level:
Needed:
Objective: Students will be able to solve two‐step equations.
Standards:
Background Information:
Math
8.EE.7b Solve linear equations in one variable
with rational number coefficients, including
equations whose solutions require expanding
expressions using the distributive property and
collecting like terms.
Materials:
Vocabulary:
isolate
standard classroom materials
inverse operations
student handouts, App. B
term
Exit Ticket, App. B
coefficient
variable
constant
Resources:
 App. B—Lesson 3: Math: Two‐Step Equations lesson notes and Exit Ticket
Procedures:
1. Distribute Two‐Step Equations lesson notes. Allow students to complete motivation. Review
and discuss as a whole class.
2. Review lesson handout; have students annotate as they follow along. Complete model
problems using gradual release scaffold.
3. Wrap up: Two‐Step Equations Exit Ticket
Differentiation:
Supports
Extensions
Assessment Opportunities:
Exit Ticket, App. B
Citations:
Exit Ticket adapted from Core Focus on Linear Equations SMC Curriculum, p23.

Building Mousetrap Cars — Science Lessons 3‐6
Grade
Level:
Objective:

8th Grade

Time
4‐50 minute periods
Needed:

Subjects: Science

To build a car that is propelled by the power from a mousetrap.

Standards:
Science
MS‐PS2‐2 Plan an investigation to provide
evidence that the change in an object’s motion
depends on the sum of the forces on the object
and the mass of the object.

Background Information:
Mousetrap cars are powered by attaching a string
that goes from the lever arm of the mousetrap to
the axle of the car. The string is wound around the
axle as the arm is pulled back. The tension in the
spring acts as the “powerplant” for the car. When
the car is set down and released, the pull of the
lever arm on the axle causes it to move forward.

Materials:
mousetraps
brazing rods
CDs
balsa wood or cardboard
hot glue guns
hot glue sticks
white glue
plastic bottle caps (optional)
drill (optional)
skewer sticks
string, etc.

Vocabulary:
lever arm
potential energy
kinetic energy

Resources:
Design ideas for mouse trap cars:
●
●

http://www.docfizzix.com/topics/construction‐tips/Mouse‐Trap‐Cars/
https://www.google.com/search?q=mousetrap+car&rlz=1C1PRFC_enUS605US605&espv=2&biw
=1366&bih=667&source=lnms&tbm=isch&sa=X&ved=0CAcQ_AUoAmoVChMI‐
LHlzPmYyAIVDS6ICh0iWA_F

Procedures:
1. Students will discuss ideas about how to power a car from a mousetrap.
2. They will be shown a model of a mousetrap car and will see various images of other types of
mousetrap cars.
3. The students will discuss some of the more important features of building mousetrap cars and
will be given some hints about how to get their cars to perform well (hints may include: straight
wheels, smoothly turning axles, end of lever arm directly above the axle, light weight, etc.).
4. The students will be given the materials and tools and will begin construction of their cars.

5. The teacher will walk around the room giving advice and direction as needed.
Differentiation:
Supports
Students will work in groups.
Assessment Opportunities:
None provided.
Citations:

Extensions

Solving Multi‐Step Equations — Math Lesson 4
Grade
Time
8th grade
50 minutes
Subjects: Math
Level:
Needed:
Objective: Students will be able to solve multi‐step equations.
Standards:
Background Information:
This lesson is meant to synthesis the prior three
Math
lessons; it asks students to use their knowledge of
8.EE.7b Solve linear equations in one variable
distributive property, combining like terms, and
with rational number coefficients, including
inverse operations to solve multi‐step equations.
equations whose solutions require expanding
expressions using the distributive property and
collecting like terms.
Materials:
Vocabulary:
isolate
standard classroom materials
inverse operations
student handouts, App. B
term
Exit Ticket, App. B
coefficient
variable
constant
Resources:
 App. B—Lesson 4: Math: Multi‐Step Equations lesson notes and example problem
 App. B—Lesson 4: Math:Multi‐Step Equations Exit Ticket
Procedures:
1. Distribute Multi‐Step Equations lesson notes. Allow students to complete motivation. Review
and discuss as a whole class.
2. Review lesson handout, have students annotate as they follow along. Complete model
problems using gradual release scaffold.
3. Wrap up: Multi‐Step Equations Exit Ticket
Differentiation:
Supports
Extensions
Assessment Opportunities:
Exit Ticket, App. B
Citations:
Exit Ticket adapted from Core Focus on Linear Equations SMC Curriculum, p29.

Solving Inequalities — Math Lesson 5
Grade
Time
8th grade
50 minutes
Subjects: Math
Level:
Needed:
Objective: Students will be able to solve and graph inequalities with one variable.
Standards:
Background Information:
This lesson introduces the concept of inequality
Math
and graphing on a number line. It is written to
HS.A‐REI.3 Solve linear equations and
inequalities in one variable, including equations meet a high school algebra standard. It can be
excluded without affecting the sequence of the
with coefficients represented by letters.
mini‐unit.
Materials:
Vocabulary:
standard classroom materials
inequality
student handouts, App. B
graph
Exit Ticket, App. B
solution set
inverse operations
Resources:
 App. B—Lesson 5: Math: Inequality lesson notes and example problems
Procedures:
1. Distribute Solving Inequalities lesson notes. Allow students to complete motivation. Review
and discuss as a whole class.
2. Review lesson handout, have students annotate as they follow along. Complete model
problems using gradual release scaffold.
3. Wrap up: “Turn and Talk.” Tell your partner the difference between an equation and an
inequality. Describe the similarities between solving an equation and an inequality.
Differentiation:
Supports
Extensions
Assessment Opportunities:
None provided
Citations:

Review—Equations — Math Lesson 6
Grade
Time
8th grade
50 minutes
Subjects: Math
Level:
Needed:
Objective: Students will review the concepts necessary to solve equations to prepare for an
assessment.
Standards:
Background Information:
This lesson included an active review to help
Math
students prepare for an equations test.
8.EE.7 Solve linear equations in one variable.
HS.A‐REI.3 Solve linear equations and
inequalities in one variable, including equations
with coefficients represented by letters.
Materials:
Vocabulary:
standard classroom materials
student handouts, App. B
Resources:
 App. B—Lesson 6: Math: Equations Review activity
Procedures:
1. Explain “Climb the Ladder” procedure. Students should work in pairs, taking turns to answer
each problem at each level. Once students have worked out the problem, paying attention to
precision, a member may approach the teacher for confirmation and the next step in the
ladder.
2. Wrap up: “Turn and Talk.” What are the steps to solve a multi‐step equation?
Differentiation:
Supports
Extensions
Assessment Opportunities:
None provided
Citations:
“Climb the Ladder” activity and problems adapted from SMC Curriculum supplemental materials.

Equations Assessment — Math Lesson 7
Grade
Time
8th grade
50 minutes
Subjects: Math
Level:
Needed:
Objective: Students will review the concepts necessary to solve equations to prepare for an
assessment.
Standards:
Background Information:
Math
8.EE.7 Solve linear equations in one variable.
HS.A‐REI.3 Solve linear equations and
inequalities in one variable, including equations
with coefficients represented by letters.
Materials:
Vocabulary:
standard classroom materials

Resources:
 None provided
Procedures:
Administer equations test.
Differentiation:
Supports
Assessment Opportunities:
None provided
Citations:

Extensions

Manual Data Collection — Science Lesson 7
Grade
Time
8th Grade
50 minutes
Subjects: Science
Level:
Needed:
Objective: To manually collect data on mousetrap cars.
Standards:
Background Information:
Science
Speed is the distance an object travels divided by
the time (S=d/t). Velocity is speed in a given
MS‐PS2‐2 Plan an investigation to provide
direction. Any unit of distance can be given over
evidence that the change in an object’s motion
any unit of time. The students will measure
depends on the sum of the forces on the object
distance in meters and time in seconds.
and the mass of the object.
MS‐ETS1‐3 Analyze data from tests to determine
similarities and differences among several design
solutions to identify the best characteristics of
each that can be combined into a new solution
to better meet the criteria for success.
Materials:
Vocabulary:
speed
masking tape
speed formula
meter stick
stopwatches or tablets with stopwatch app. velocity
data
graph paper (optional)
Procedures:
The teacher will find a smooth, flat area to test the cars on. A starting line will be marked on the floor
with masking tape. Tape will also be placed at 1 meter intervals for a total of 12 meters (this can be
longer if the cars are expected to go farther and if there is room.) Students will be placed at each meter
interval taped line. The teacher will instruct them that when the teacher says to go, one group of
students that is ready to test their car will release it from the starting line. Upon the command, all the
students with timers will start their timer. As the car reaches each interval, the students at that tape
mark will stop their stopwatch. The group will then go along the line and fill in the times that the car
took to go each meter. The students will make a t‐chart of their data, and will later graph the data in
order to see a relationship.
Differentiation:
Supports
Extensions
Students will all work together to collect the data. Advanced students may be asked to come up with
other ways to measure the speed, and to actually
take those measurements to see if they are close
to the values that were obtained using this
method.
Assessment Opportunities:
None provided.

The Coordinate Plane — Math Lesson 8
Grade
Time
8th grade
50 minutes
Subjects: Math
Level:
Needed:
Objective: Students will recognize and graph ordered pairs on a coordinate plane.
Standards:
Background Information:
This lesson is meant to reacquaint students with
Math
the coordinate plane and plotting points. For some
6.NS.8 Solve real‐world and mathematical
problems by graphing points in all four
students it may be review, for others it may all
quadrants of the coordinate plane. Include use
seem brand new. Using the metaphor of “cross
of coordinates and absolute value to find
streets” may help students understand a point is
distance between points with the same first
located where two number lines intersect and its
coordinate or the same second coordinate.
name actually describes a location.
Materials:
Vocabulary:
coordinate plane
standard classroom materials
ordered pair
student handout, App. B
origin
quadrant
x‐axis
y‐axis
plot
Resources:
 Appendix B—Lesson 8: Math: Coordinate Plane & Linear Plots
Procedures:
1. Distribute lesson notes, allow students to complete Motivation. Review and discuss.
2. Review lesson handout, have students annotate as they follow along. Complete model
problems using gradual release scaffold.
3. Wrap Up: Sink the Sir Activity‐ Sink the Sir is a paper version of the board game Battleship.
Students plot five ships on their coordinate plane. Pairs take turns guessing the position of
their opponent’s ships. When a student correctly guesses the number of points associated
with the type of ship, it is “sunk.” The object of the game is to “sink” the opponent’s five ships
first. Students should record their guess and their opponent’s guesses as ordered pairs.
Differentiation:
Supports
Extensions
Assessment Opportunities:
None provided
Citations:

Data Collection with Vernier — Science Lesson 8
Grade
Time
8th Grade
50 minutes
Subjects: Science
Level:
Needed:
Objective: To collect data from mousetrap cars using Vernier motion sensors technology.
Standards:
Background Information:
Science
Some experience using the Vernier Labquest 2 and
motion sensor is helpful.
MS‐PS2‐2 Plan an investigation to provide
evidence that change in an object’s motion
depends on the sum of the forces on the object
and the mass of the object.
MS‐ETS1‐3 Analyze data from tests to determine
similarities and differences among several design
solutions to identify the best characteristics of
each that can be combined into a new solution
to better meet the criteria for success.
Materials:
Vocabulary:
data
mousetrap cars
sensor
tape
Labquest 2 (1 per group if possible, but a
couple per class could work)
motion sensor
printer if available.
Procedures:
The students will go to the same place to collect data that they did in the previous lesson, so that the
data will be more consistent. Each group will have a Vernier Labquest and motion sensor. They will all
start on the same line and will have the motion sensor behind their mousetrap car. They can then start
their car and collect data using the Labquest. It is not necessary for all of the students to start at the
same time since they will be collecting data each time with the Labquest. After the data is collected, the
graph of the data may be printed out, or just saved on the Labquest for further analysis. If it is being
saved on a Labquest and there are multiple Labquests, the students will need to keep track of which one
their data is stored on. The students will analyze their data to determine the speed of their car from the
graph.
Differentiation:
Supports
Extensions
Students will be working in groups.
Advanced students may be asked to look at some
of the statistics of the graph and see if they can
get a line of best fit for their data.

Scatter Plots & Correlations — Math Lesson 9
Grade
Time
8th grade
50 minutes
Subjects: Math
Level:
Needed:
Objective: Students will recognize and graph ordered pairs on a coordinate plane.
Standards:
Background Information:
This lesson is meant to introduce students to the
Math
concept of plotting their data on a coordinate
8.SP.1 Construct and interpret scatter plots for
plane and informally describing the pattern they
bivariate measurement data to investigate
patterns of association between two quantities. observe. The underlying goal is to establish that
data in the real world is messy and we need tools
Describe patters such as clustering, outliers,
to help us interpret data and patterns, which sets
positive or negative associations, linear
the stage for the following lesson: drawing a line
association, and nonlinear association.
of best fit and making predictions.
Materials:
Vocabulary:
standard classroom materials
Statistics
data
mouse trap car data (from science class)
single‐variable data
scatter plot
Resources:
 None provided
Procedures:
1. Review previous day’s discussion about linear plots.
2. Introduce the concept of scatter plots. Explain terms:
Statistics‐ process of collecting, displaying, and analyzing a set of data
Single‐variable data‐ shows one type of data
Two‐variable data‐ two types of data are considered at the same time
Scatter plot‐ plotting two variable data set as ordered pairs in order to analyze the
relationship between the two variables
3. Model plotting data from mouse trap car data.
4. Have students create scatter plots that include various sets of data from different groups.
This will create a fuller picture of the data and prepare students for tomorrow’s lesson:
drawing the line of best fit.
5. Wrap Up: Ask students to describe other real world situations that would have positive
correlations. Then have them discuss situations that would be represented by negative
correlations.
Differentiation:
Supports
Extensions
Assessment Opportunities:
None provided
Citations:

Redesign — Science Lesson 9
Grade
8th Grade
Level:
Objective:

Time
50 Min
Needed:

Subjects: Science

Students will redesign their cars to see if their changes improve the speed of their car.

Standards:
Science
MS‐PS2‐2 Plan an investigation to provide evidence
that change in an object’s motion depends on the
sum of the forces on the object and the mass of
the object.

Background Information:
The easiest modification of their car can be in just
shortening the lever arm. This can be the only thing
changed by the students, or the teacher may allow
the students to make other modifications that they
think will improve the speed of their car. Each car
may have only one modification in between tests, so
that the students are able to determine how the
MS‐ETS1‐3 Analyze data from tests to determine
particular modification changed the performance of
similarities and differences among several design
solutions to identify the best characteristics of each the car.
that can be combined into a new solution to better
meet the criteria for success.
Materials:
mousetraps
brazing rods
CDs
balsa wood or cardboard
hot glue guns
hot glue sticks
white glue
plastic bottle caps (optional)
drill (optional)
skewer sticks
string

Vocabulary:
modification
lever arm

Resources:
None provided.
Procedures:
1. After collecting the data from the previous lesson, the students choose one particular feature
about their car that they think they can change that will improve the speed of the car over the 5‐
10 meter distance.
2. They make the change to their car. The students are only allowed to make one modification at a
time before they collect data.
Differentiation:
Supports
Extensions
Students will work in groups.
Students may be allowed to make several

modifications as long as they collect the relevant
data after each modification is made.
Assessment Opportunities:
None provided.
Citations:

Predicting with Lines of Best Fit — Math Lesson 10
Grade
Time
8th grade
50 minutes
Subjects: Math
Level:
Needed:
Objective: Students will recognize and graph ordered pairs on a coordinate plane.
Standards:
Background Information:
This lesson seeks to combine students’
Math
8.SP.1 Construct and interpret scatter plots for understanding of linear relationships and scatter
plots and help them understand data is “messy”
bivariate measurement data to investigate
patterns of association between two quantities. but we can still interpret relationships and make
Describe patters such as clustering, outliers,
predictions based on linear associations.
positive or negative associations, linear
association, and nonlinear association.
8.SP.2 Know that straight lines are widely used
to model relationships between two
quantitative variables. For scatter plots that
suggest a linear association, informally fit a
straight line, and informally assess the model fit
by judging the closeness of data points to the
line.
Materials:
Vocabulary:
line of best fit
standard classroom materials
data set
student handout, App. B
scatter plot
Resources:
 Appendix B—Lesson 10: Math: Predicting with the Line of Best Fit
Procedures:
1. Distribute lesson notes, allow students to complete Motivation. Review and discuss.
2. Review lesson handout, have students annotate as they follow along. Complete model
problems using gradual release scaffold.
3. Have students then apply concept of line of best fit to the scatter plots they created the
previous lesson. Ask them to make predictions and justify their predictions as well as evaluate
the lines of best fit of classmates. Be sure they can justify their evaluations applying the
parameters for line of best fit presented in the lesson.
4. Wrap up: Ask students to describe characteristics of a good line of best fit. Then ask for
examples of how students could use lines of best fit to make predictions about real world
data.
Differentiation:
Supports
Extensions
Assessment Opportunities:
None provided

Data Collection — Science Lesson 10
Grade
8th Grade
Level:
Objective:

Time
50 min
Needed:

Subjects: Science

Data Collection, both manual and motion sensor.

Standards:
Science
MS‐PS2‐2 Plan an investigation to provide
evidence that change in an object’s motion
depends on the sum of the forces on the object
and the mass of the object.

Background Information:
Students already familiar with both manual and
sensor data collection should be able to collect data
both ways in the same class period.

MS‐ETS1‐3 Analyze data from tests to determine
similarities and differences among several design
solutions to identify the best characteristics of
each that can be combined into a new solution to
better meet the criteria for success.
Materials:
masking tape
meter stick
stopwatches or tablets with stopwatch app.
graph paper (optional)
mousetrap cars
tape
Labquest 2 (1 per group if possible, but a
couple per class could work)
motion sensor
printer if available.

Vocabulary:

Procedures:
The students will collect data for their car’s speed using both the manual stopwatch and meter stick
method and the Vernier Labquest and sensor method.
Differentiation:
Supports
Students are working in groups.
Assessment Opportunities:
None Provided
Citations:

Extensions

Graphing Your Motion (Vernier Lab) — Math Lessons 11‐12
Grade
Time
8th grade
50 minutes x 2
Subjects: Math
Level:
Needed:
Objective: Students will recognize and graph ordered pairs on a coordinate plane.
Standards:
Background Information:
Math
Students will need time to explore the Vernier labs
if they have not had a chance to use them
previously. This lab is meant to reinforce the
concepts of collecting data, plotting scatter plots,
informally determining the line of best fit and
making predictions based on the data.
Materials:
Vocabulary:
standard classroom materials
student handout
Vernier Labquests (one per group)
Vernier Labquest #33 handout
“Graphing Your Motion”

Resources:
 App. B—Lesson 11‐12: Math: Vernier LabQuest #33 “Graphing Your Motion”
Procedures:
Day 11
1. Have students acquaint themselves with the labquests. Facilitate exploration or allow
students to explore on their own with guiding notes.
2. Break students into groups (number of groups depends on number of labquests available).
Introduce the lab and its objectives. Begin lab if time permits.
Day 12
1. Facilitate “Graphing Your Motion” Lab.
2. The lab actually creates a table and scatter plot of data on the labquest. Have students use
the data table to create their own scatter plots and compare. Then have students determine
lines of best fit and discuss their meaning.
3. Wrap up: Evaluate with relevant justifications the lines of best fit and inferences based on
the data.
Differentiation:
Supports
Extensions
Assessment Opportunities:
None provided
Citations:


Vernier LabQuest #33, Middle School Science with Vernier

Data Interpretation — Science Lesson 11
Grade
8th grade
Level:
Objective:

Time
50 min
Needed:

Subjects: Science

The students will graph their data and discuss whether modifications changed their rate of
speed for their car.

Standards:
Science
MS‐PS2‐2 Plan an investigation to provide
evidence that change in an object’s motion
depends on the sum of the forces on the object
and the mass of the object.

Background Information:
A graph of distance and time is usually given with
the time along the x‐axis and the distance on the y‐
axis. The graphs should be labelled with units and a
title should be written at the top of the graph.

MS‐ETS1‐3 Analyze data from tests to determine
similarities and differences among several design
solutions to identify the best characteristics of
each that can be combined into a new solution to
better meet the criteria for success.
Materials:
standard classroom materials
graph paper

Vocabulary:
graph
x‐axis
y‐axis
velocity

Resources:
●
Procedures:
1. The students will graph data that they have collected and will compare the results of their
graphs of both the manual and Labquest data that they collected and the before‐modification
and after‐modification data.
2. They will be asked if their modifications increased or decreased their car’s velocity.
Differentiation:
Supports
Students will work in groups.
Assessment Opportunities:
None Provided
Citations:

Extensions

Walk the Line: Straight Line Distance Graphs— Math Lesson 13
When one quantity changes at a constant rate with respect to another, we say they are linearly
related. Mathematically, we describe this relationship by defining a linear equation. In realworld applications, some quantities are linearly related and can be represented by using a
straight-line graph.
In this activity, you will create straight-line, or constant-speed, position versus time plots using a
Motion Detector, and then develop linear equations to describe these plots mathematically.

OBJECTIVES
 Record distance versus time data for a person walking at a uniform rate.
 Analyze the data to extract slope and intercept information.
 Interpret the slope and intercept information for physical meaning.

MATERIALS
TI-Nspire handheld or
computer and TI-Nspire software
CBR 2 or Go! Motion, or
Motion Detector and data-collection interface

PROCEDURE

1. If your Motion Detector has a switch, set it to Normal, as shown.
Connect the Motion Detector to the data-collection interface. Connect
the interface to the TI-Nspire handheld or computer. (If you are using a
CBR 2 or Go! Motion, you do not need a data-collection interface.)
2. Position the Motion Detector on a table or chair so that the head is pointing horizontally out
into an open area where you can walk. There should be no chairs or tables nearby.
3. Choose New Experiment from the Experiment menu. For this experiment, the default
data-collection parameters for a Motion Detector will be used (Rate: 20 samples per second;
Duration: 5 seconds). The number of points collected should be 101.
4. Stand about a meter from the Motion Detector. When you are ready to collect data, walk
away from the Motion Detector at a slow and steady pace and start data collection ( ). You
will have five seconds to collect data.
5. When data collection is complete, choose Show Graph ► Graph 1 from the Graph menu,
a graph of distance vs. time will be displayed. Examine the graph. It should show a nearly
linearly increasing function with no spikes or flat regions. If you need to repeat data
collection, repeat Step 4.
6. Once you are satisfied with the graph, sketch or print copies of the graph as directed by your
teacher.

DATA TABLE
y-intercept, b
optimized slope, m
optimized line equation
x 1, y 1
x 2, y 2
regression line equation

ANALYSIS
1. Click any data point and use ► and ◄ to read the values from the graph.
2. The slope-intercept form of a linear equation is y = mx + b, where m is the slope of the line
and b is the y-intercept value. The independent variable is x, which represents time, and the
dependent variable is y, which represents position in this activity. Trace across your graph to
the left edge to read the y-intercept. Record this value as b in your data table.

3. One way to determine the slope of your position vs. time graph is to guess a value and then
check it by viewing a graph of the line. To do this, use the movable line feature of Data &
Statistics.
a. Add a new Data & Statistics page to your document (handheld – Select Insert ► Data &
Statistics from the Documents menu; computer – Select Data & Statistics from the Insert
menu.)
b. Add time as the variable for the horizontal axis.
c. Add position as the variable for the vertical axis.
d. Choose Add Movable Line from the
Data & Stats Analyze Menu.
e. Move the cursor over the movable line. Near the center of the movable line, the cursor
will appear as a four-directional icon. Away from the center of the movable line, the
cursor appears as two arrows in a circular arrangement. Grasp the movable line to
translate and rotate it.
f. Experiment with your movable line to find the best value for m and record the optimized
value in the data table.
4. Use the values of the slope and intercept to record in your data table the equation of the line
that best fits your position vs. time data.
5. Another way to determine the slope of a line to fit your data is to use two well-separated data
points. Choose two points (x1, y1) and (x2, y2) that are not close to each other and record them
in the data table.
6. Use the points in the table to compute the slope, m, of the position vs. time graph.
y  y1

m 2
x 2  x1
Answer Analysis Question 1.
7. You can also use Data & Statistics to automatically determine an optimized slope and
intercept.
a. Choose Remove Movable Line from the Analyze Menu.
b. Choose Regression ► Show Linear (mx+b) from the Analyze Menu.
c. Use the parameters m and b to record the equation of the best-fit regression line in your
data table.
d. (optional) Print your graph.
8. Answer Analysis Questions 2–5.

ANALYSIS QUESTIONS
1. How does this value compare with the slope you found by trial and error?
2. How do the values of the slope and intercept as determined by the calculator compare to your
earlier values? Would you expect them to be exactly the same?

3. Slope is defined as change in y-values divided by change in x-values. Complete the following
statement about slope for the linear data set you collected.
In this activity, slope represents a change in ______________________________ divided by
a change in ______________________________.
4. Based on this statement, what are the units of measurement for slope in this activity?
5. The y-intercept can be interpreted as the starting position or the starting distance from the
Motion Detector. What does the slope represent physically? Hint: Consider the units of
measurement for the slope you described in the previous question.
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Engineering Work Sample — Science Lessons 12‐13
Grade
8th grade
Level:
Objective:

Time Two 50‐minute
Needed: periods

Subject: Science

Discuss Engineering Work Sample and begin their own work sample.

Standards:
Science
MS‐PS2‐2 Plan an investigation to provide
evidence that change in an object’s motion
depends on the sum of the forces on the object
and the mass of the object.

Background Information:
Familiarity with the state scoring rubric for
engineering and design is helpful in explaining to the
students how they will be graded.

MS‐ETS1‐3 Analyze data from tests to determine
similarities and differences among several design
solutions to identify the best characteristics of
each that can be combined into a new solution to
better meet the criteria for success.
Materials:

Vocabulary:

Resources:
● App A—Lesson 12‐13: Engineering Scoring Guide
● App B—Lesson 12‐13: Engineering Work Sample Template
Procedures:
1. The teacher will hand out and discuss the state scoring rubric for the engineering and design
work sample.
2. The students are given the work sample writing page to fill in for their work sample.
Differentiation:
Supports

Extensions

Assessment Opportunities:
Students will complete an engineering work sample using the template.
Citations:
● Engineering Design Work Sample Template
http://www.nclack.k12.or.us/cms/lib6/OR01000992/centricity/domain/125/ed_work_sample_t
emplate_ms.pdf
● Engineering Design Work Sample Scoring Guide
http://www.ode.state.or.us/wma/teachlearn/testing/scoring/guides/2011‐
12/science_engineering_design_gr6‐8_eng.pdf

NCSD Engineering Design Work Sample Template MIDDLE SCHOOL 2011-2012

